Learning Avogadro - The Molecular Editor

Importing Molecules by Name

Select the "File" menu.

Edit View Build

L New #EN
Open #®0 7
Open Recent [
Close W
Save 385
Save As... {+385
Revert To Saved
Import >
Export >

Then select "Import", and "Fetch by chemical name..."

mEdjt View Build Select Extensions Crystallog

| New 38N df - Avogadro
Open %0  Tool Settings... | | Display Settings.
Open Recent >

Close *EW

Save 285
Save As... {+385
Revert To Saved
Molecule File...

Trajectory...

Crystal...

Fetch from PDB...

Fetch by chemical name...
Fetch from URL...

A dialog box will pop up (depicted below), where you can type in any chemical name.

‘@00 A Chemical Name

Chemical structure to download.
|
[ Cancel | [ .OK..]

Avogadro will import the molecule into the viewing screen after you click "OK".
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‘@00 A Chemical Name

Chemical structure to download.

Water|
Cancel | OK |
—k_.

It may take a few seconds or even a minute to download the molecule online. Avogadro uses the NIH "Chemical Resolver"
http://cactus.nci.nih.gov/chemical/structure to convert the name into a molecular structure.

, 800 Water.sdf - Avogadro

Sl B kD E RS Tool Settings... | Display Settings...

View 1
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Importing from the Protein Data Bank (PDB)
You can read PDB files that you download yourself from http://www.rcsb.org/ or access the PDB code yourself.
Importing directly

Older versions of Avogadro have a bug with direct access to the PDB (since the website has moved) but using v 1.2.0, you
can again use File > Import > Fetch from PDB... to download proteins.

ﬂ Edit View Build Select Extensions Crystallog

New 38N untitled.c

' Open #0 -
2 Open Recent o elRlBdinge., LDIROYD
. Close EW

Save As...

Maolecule File...

Export

Duplicate : Fetch from PDB...

Fetch from U

—

Draw Settings L...

A dialog will come up and allow you to enter a PDB code (e.g., 1CRN for crambin)

®  ® A PDB Entry

PDB entry to download.

N

cancel (OKI

There it is... the PDB data direct from the website.
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The Draw Tool

1. Creating a Molecule

Molecules can be built and edited with the draw tool.

[E

& R D § S

Draw Settings

Element: | Carbon (B)

a4k

Bond Order: | Single -
(v Adjust Hydrogens

2.

You can begin creating a molecule by left clicking on the black display. This will generate a carbon atom. Right clicking on
the atom will delete it.

800 untitled.cml - Avogadro

| 4+ o5 k3 E i oo [SioolSetings.s Display Sattings.,

3
(=W =] D Eatinga
Samant; | Carban (B)
Bond Oirdar Single

[+ Adjust Hydrogans

3.

Left clicking and dragging the mouse will generate a bond to another carbon atom.
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-XaXs! untitled.cml - Avogadro
# 4 B 5 &k D E o 4 [FicclSsiings= | Dispay Setings..
(2]~ D Ballivga l ) Ve 1

Elemant:  Carbon (5)

Bord Ordes:  Bingle

wf Acjust Hydrogers

4.

Different elements can be selected from the Element drop down menu. Typing the atomic symbol (e.g., "A-s" for Arsenic) is
a shortcut for changing the selected element.

® 00
M+ ke & kD Em s @
00O _ Hydmg_en {1_}
Element:
. Oxygen (8)
Bl Cheis g Fluorine (9)
. Phosphorus (15)
ET sty Sulfur {16}
Chlorine (17)
Bromine (35)
Other...

5.

For example, if you wanted to create water, you can type in "O", or select "Oxygen (8)" from the drop down menu and click
on the black display.
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@06 untitled.cml - Avogadro
B+ k2 & k D § o o | (SN | Deray Setinge.
08 Ceaw Eattings 0 View 1
Elamant; | Cwygean (B] :
Bond Ordar: | Single
o Adjust Hydrogens

6.

If the "Adjust Hydrogens" box is checked, hydrogens in the molecule are automatically adjusted to satisfy valency (as
shown above).

@00
a @I Draw Setftings

Element: | Carbon (6)

4k

Bond Order: | Single 4

(] Adjust Hydrogens

7.

Bond order can be changed through the Bond Order drop down menu, or by typing the numbers "1", "2", or "3". Bonds can
also be added to a molecule by left clicking on a bond that has already been created (this process cycles through single,
double, and triple bonds). Right clicking on a bond will delete the bond, and the atom it's bonded to.
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e 00
4+ ke & kD F om o
ﬂ @ Draw Setftings
Element: | Carbon (B) ¢.|
Bond Order: ?|
- )
[ Adjust H _

8.

For example, to create carbon dioxide, the general structure ("O-C-0") needs to be drawn, and then by left clicking the
bonds in the molecule, double bonds will be created.

Draw Tool

65



Learning Avogadro - The Molecular Editor

- NaNs) untitled.cml - Avogadro
B+ e & & O § i o SN ( Dpiey Setings..
(<N ] Draw Seflings
Element: | Oxygen (8) .
Bond Order: | Single + Y

[ Adjust Hydrogens:

e+ e & kD F o 'M‘J Display Seffings...
0 @ Draw Seftings e .. SR R
Element: | Oxygen (8) .
Bond Order: | Single s

+/ Adjust Hydrogens

'l.

-NsNs untitled.cml - Avogadro
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00 Draw Seftings L @ View 1

Element: | Oxygen (8) s

Bond Order: | Single

] Adjust Hydrogens
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9.

Under the "Extensions" menu, the geometry of a molecule can be optimized by selecting "Optimize Geometry".

Crystallography Window Help

Animation... untitled.cml - Avogadro

Ant : | Display Sattings...

Molecular Mechanics

= CAMESS
8 Abinit...
Dalton...
CAMESS-UK...
dregens  Gaussian...
MOLPRO...
MOPAC...
NWChem...
Psi4...
Q-Chem...
LAMMPS...

Singh

Molecular Orbitals...
QTAIM

Spectra...
Create Surfaces...
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The Navigate Tool

The navigation tool is used to pan, rotate, and scale the view of a molecule.

H kD B oo

Mavigate Settings

[ Display visual cues

If the "Display visual cues" box is checked, yellow arrows will display what type of navigation is taking place.

800
Lkl & Rk D §F o o
IE:) @I Mavigate Settings

[/ Display visual cues

Clicking anywhere on the black display and dragging the mouse will tilt, and rotate the entire molecule (as shown below).

-Nals untitled.cml = Avogadro
Sl 5 k D § i o [AToolSsingsa|  Display Setings.
an Navigate Salings

(¥ Display visual cues
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A molecule can also be rotated about an atom by clicking the atom and dragging the mouse. Depicted below, acetone is

being rotated about it's initial carbon.

®no untitled.cm| - Avegadro
e e S * B E oraoa | Tool Setlings.... Disglay Settings...
o% Mavigain Sattings

[ Display visual eues

Right clicking allows you to change the molecules location on the display. Double clicking the molecule will reset the
molecule's view.
‘ann untitled.cml - Avogadro

Zille & k D § nx o [N | sy Seing

o0 hiarvigaly Sellirgs | & views

[ Display visual cuss

Using the middle scroll bar on a mouse will allow you to zoom in and out.

Navigate Tool
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(—
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o8 Mevigane Setings
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Navigate Tool

untitled.cml - Awagadra
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The Bond-Centric Manipulate Tool

The Bond-Centric Manipulate tool alters angles, bonds, and torsions of a molecule.

8086
2 =)o x > § w ~ BB
IE:) @I Bond Centric Manipulate Settings

[+ Show Angles
[+ Snap-to Bonds

Snap-to Threshold: 10° 5

Left clicking on a bond and dragging your cursor allows you to adjust the plane. If the "Show Angles" box is checked, the
angles from the selected bond to all adjacent bonds are displayed.

-‘;_\.ﬂﬁ

# 4| % k D E n: o  [ToolSeingsiil | Display Sefiings..

untitled.cml - Avogadro

[x Y] Bond Centric Manipulate Setings
~ Shaw Angles
Snap-to Threshold: 10°

As you're rotating the plane you'll notice that if the "Snap-to Bonds" box is checked, the plane will change colors between
yellow and blue. If the plane depicted is yellow then the plane is in line with an adjacent bond. If the plane depicted is blue
the plane is not in line with any adjacent bonds.

The "Snap-to Threshold" determines how far away a plane has to be to snap to an adjacent bond plane. For example,
below the Snap-to Threshold is 10 degrees. If the plane being rotated comes within 10 degrees of an adjacent bond, that
plane will snap to the adjacent bond plane. If the Snap-to Threshold is changed to 90 degrees, the rotating plane will only
shap to adjacent bond planes.
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‘o0 untitled.cml - Avogadra

S 4+ =l 5 K D 8 L +  [FTooiSelingsns] | Display Setiings..

a0 Band Ceniric Manipulate Setings

(¥ Snap-to Bonds
Snap-to Threshaold: 10°

Once a plane is selected the atoms on either end of the plane can be manipulated, by left clicking on the atom and
dragging. The displayed angles will automatically adjust, and the selected bond will not change in length.

. ® 00 untitled.cm| - Avogadro
S B D OE o | Tool Settings... | Display Settings... |
Q @ Bond Centric Manipulate Settings £ View 1

[ Show Angles
[ Snap-to Bonds

Snap-to Threshold: 90° =

Left clicking on a substituent, or in this case a hydrogen bonded to one of the selected carbon atoms will allow you to adjust
the torsion angle.
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® 00
2 4|5 k O § o o (elSeeoaS

(x N Bond Ceniric Manipulaie Settings .

(W Show Angles

W Snap-to Bonds
Snap-to Threshold: 80°

untitled.cml - Avogadro

Display Settings...
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The Manipulate Tool

The manipulate tool allows you to move atoms and selected fragments.

@00
7 + .
IE:) @I Manipulate Settings
Translate by:
X (A) Y (A} Z(A)
0.0000 ||, 0.0000 ||, 0.0000 ||,
Rotate around: | Geometry N
X-axis Y-axis Z-axis
0.00° ||, 0.00° ||, 0.00° ||,
Reset Apply

If inserting a fragment, the manipulate tool is automatically selected so that the fragment can easily be rotated into position.

The "Translate by:" section allows you to easily translate the length of a bond (to a fragment or atom) into the desired
positon. For a translation to take place, enter in the desired translation and then click "Apply".

‘@00 untitled.cml - Avogadro
£ 4 | * H E 52 oA |: Tool Seftings... | Display Settings... |
0 @ Manipulate Settings
Translate by:
X (A) ¥ (A} Z(A)

0.0000 | 10.0000 | . 0.0000 | o

Rotate around: | Origin
X-axis Y-axis Z-axis

0.00° | , 0.00% | 0.00° ||

Resel Apply o
o

The "Rotate around:" section allows you to rotate your selection around the geometry, or the origin. This section then gives
you the ability to choose how many degrees to rotate the fragment. Click "Apply" once you've made your selection.
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‘@00 untitled.cml - Avogadro
# + 2|5 & 5 & nr o (FioolSsilingses) | Display Sefiings..
(x N ) Manipulate Settings
Translate by:
X () Y (A) Z{A)
0.0000 ||, 10.0000 | . 0.0000 |,
Rotate around: | Geometry . o
X-axis Y-axis Pais
80.00° |[* 0.00° | * 0.00°
Resat Apply o
'

Clicking "Reset" will reset all of the information in the translation, and rotation boxes. This does not reset the molecule, if
you want to undo your adjustments go to the "Edit" menu in the top bar and select "Undo Manipulate Atom".

Manipulate Tool
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‘@00 untitled cml - Avogadro
S 4+ Sk D5 Lo .m| Display Setiings...
006 Manipulate Settings l © View 1
Translata by:
X (A) Y (A) Z(A)
0.0000 | X 0.0000 | - 0.0000
Rotate around: | Geometry s
X-axis Y-axis Z-axis
0.00° [* 0.00% | 0.00° |[*
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tensions Crystallography Window Help
untitled.cml = Avogadro

[ Avogadro  File -8 View Build Selec

ao inipulate Atc
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Copy
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Paste
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The Selection Tool

The selection tool allows the indiviual selection of atoms, bonds, or fragments.

,@ ——
7 4 I q®3 E oo (O
0 @I Selection Settings

Selection Mode: | Residue N

Add Center of Atoms

Add Center of Mass

There are three types of selection modes: "Atom/Bond", "Residue", and "Molecule".

The "Atom/Bond" selection mode provides you with the ability to select a single atom within a molecule. This is achieved by
left clicking the atom. Pressing down the "Shift" button on your keyboard allows the selection of multiple atoms.

Right clicking on the black display will clear the selection made.

. 800 untitled.crml - Avagadro
A b o 5 (k| D E 5w |WTeelSefings.| | Display Sattings..
Cl' @ Selecton Senings

Salection Modse: | Atom/Bond =

Add Canter of Aloms

o

Add Center of Mass

The "Residue" selection mode will select an entire residue within the molecule, by clicking on a single atom in the residue.
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‘ano untitled.cml - Avogadro
P S * | 5 § % = - Tool Seflings... Diaplay Setlings..
oo Selection Sallings

Selection Mode: | Residue =

Add Center of Atoms

Add Cenler of Mass

The "molecule” selection mode will select the entire molecule by clicking on an atom. Double clicking the molecule will also
select the entire molecule.
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@00 untitled.cml - Avogadro
L 4+ G D 5 oL e .:—-_WM-—] Dusplay Setlings..
a8 Sulection Setings

Add Center of Mass

Molecules can also be selected by clicking and dragging your cursor across the display.

‘& nn untitled.cml - Avogadro
FAES TR * | o E o Y l...m..dj DCisplay Setings...
(=] SRCION Saming

Balmction Mode: | Molecule x

Add Canter of Aloms

Add Canter of Mass
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Clicking on "Add Center of Atoms" will display a black ball where the center of the atoms is found.

‘ann untitled.crml - Avogadro
S 4 Sed B o o |- Tool Setings... Display Selfings. .
a6 Selection Sefings

Balaction Mods: | Malecule =

Add Center of Aloms

Clicking on the "Add Center of Mass" will display a black ball where the center of mass of the molecule is found.

Selection Tool
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—

P v e Dd E oz o |- Tool Saftings.... | Display Satfings... |
oo Sanclion Semngs
Selection Mode: | Molecule

Add Center of Atomsa
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B e

Selection Tool
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The Auto-Rotate Tool

The auto rotate tool allows for the continuous rotation of a molecule.

8086
P LA o .
IE:) @I AutoRotate Setlings
® rotation:
y rotation: (Y
z rotation: ()
Start Reset

To rotate the molecule, adjust the X, y, and z rotation scales as desired. Then select "Start".

‘@00 untitled.cm| - Avogadro
# o oS kB E o s | Tool Setings... Display Settings..

Q5 o AuinFintate Sefings

¥ rotation

v rotabion:

Z rotation:

o Slart Resel
o

You can also click and drag from an atom to rotate the molecule in a specific direction.
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uritltlad om| - Avagadnn
A+ =y ko B o oo [FToclSelingal] | Dieplay Selirgs
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xroleton:
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Select "Stop" to end the molecule's rotation.

untitled.cm| - Avogadro
o e & ki E o Tool Settings... Display Settings..

Q 'ﬂj AuaoRotale Settings

= rolation:

 rofation:

Z rofation:

H‘!x:

Clicking "Reset" will zero out the rotation scales and stop the rotation.

Auto-Rotate Tool
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" Walal untided.cml - Avogadro

S s kD E o e |- Tool Sattings... | Display Sattings..
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x rotation:
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The Auto-Optimize Tool

The Auto Optimize tool continuously optimizes molecular geometry through molecular mechanics. This tool also gives you
the ability to manipulate the molecule while the molecular geometry is being minimized.

® 00 :
R SRR 3 s [EE
(x N =] AutoOptimization Settings

Force Field: | UFF L)

Steps per Update: |4 |[*]

Algorithm:

| Steepest Descent B

| | Fixed atoms are movable
| | lgnored atoms are movable

| Start |

The Auto-Optimization settings provide several force field options. The default force field is UFF or the Universal Force
Field. This force field is capable of reproducing the most structural features across the periodic table. However, depending
on the molecule being tested, the other force fields may be better suited to optimize the molecular parameters. The force
field options are shown below. For more information on force fields refer to the optimizing geometry section of this lab

manual.
@00
2+ s kG s B
Ghemical
00 AuioOg  \niFEos

- MMFF94s L
Force Field: v UFF »

Steps per Update: |4  |[*]

Algorithm:

| Steepest Descent B

| | Fixed atoms are movable
[ | lgnored atoms are movable

| Start |

The default setting for "Steps per Update" is 4. This number can be increased or decreased, if you have a slower computer

consider decreasing this number.
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2+ & kD~ B

(x N =] AutoOptimization Settings

Force Field: | UFF L)

Steps per Update: |4 (2]

Algorit

| Steepest Descent +

| | Fixed atoms are movable
| | lgnored atoms are movable

| Start |

Avogadro can also apply specific algorithms dependent on your need. Steepest descent is the most fluid and interactive
system, and is the default algorithm.

® 00 :
Z 4 & Rk D|Eum < BE
(x N =] AutoOptimization Settings

Force Field: | UFF ™

Steps per Update: |4 |[*]
Algorithm:

+ Steepest Descent N
Conjugate Gradients
Molecular Dynamics (300K}
Molecular Dynamics (600K)
Molecular Dynamics (300K}
“ — J

If necessary, atoms can be fixed into place before optimization so that they don't move. This is done by going to the
"Extensions" menu, holding your cursor over "Molecular Mechanics" and selecting "Fix Selected Atoms".

Auto-Optimize Tool
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#f Avogadro File FEdit View Build
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Forca Field: | UFF
Steps per Update: 4
Algorithm:
Steepest Descent

Fixed atoms are movable
Ignored atoms are movable

Start

"  Optimize Ceometry

o lar AnIcs

GAMESS
Abinit...
Dalton...
GAMESS-UK...
Gaussian...
MOLPRO...
MOPALC...
NWChem...
PSl4...
Q-Chem...
LAMMPS...

Molecular Orbitals...

QTAIM

Spectra...
Create Surfaces...

Select WITELLEY Crystallography  Window  Help
| Animation...
| Teol Setting

Setup Force Field...

Calculate Energy |
Conformer Search...

Constraints...
Ignore Selection

- \Lom:

Clicking on "Start" will allow you to manipulate the molecule by left clicking on an atom and dragging your cursor. Notice

that the fixed atoms don't bend with the manipulation of the molecule.

& nn
24+ o kD)=

20 AuloDptimization Setlings

Force Field: | UFF
Steps per Update: |4 e

Algarithm:
Stespest Descent
Fixed atoms ane movabhke

Ignored atorms ane movable

Stop

untitled.cm| - Avogadro
Tool Selfings... | Display Setlings...

AutoOpt: E = 17827.7 kJ/mol (dE = 1260.54)

Nurm Constraints: 22

If the "Fixed atoms are movable" box is checked, the bonds between atoms can be manipulated but are constrained. In this

instance the selected atom does not reoptimize once it's dragged.

Auto-Optimize Tool
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800 untitled.cml - Avogadro
S+l B K DB ni o [(FTeclSefings.|  Display Settings..
00 AutoDptimization Setlings

Force Field: = UFF

Steps per Update: |4 -

Mum Conskraints: 24

Algorithm:
Steepest Descant -

|f Fixed atoms are movable
lgnored atoms are movable

Slop

B AutoOpt: E = 419617 kdimol (dE = 0.0388442)

Essentially, the same thing takes place if the "Ignored atoms are movable" box is checked. However, ignored atoms (if the

box is checked) will reoptimize once dragged. To ignore a selection select the "Extensions" drop down menu, hold your
cursor over "Molecular Mechanics" option, and select "Ignore Selection".

The molecule will reoptimize until dE=0 or "Stop" is clicked.
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